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1.0 OTDR Quick Start Guide 
 

Press  to turn on the OTDR.   

The OTDR function will be highlighted.  Press  to initiate the OTDR application. 

Connect the fiber to the appropriate port. (Select Multi Mode or Single Mode if OTDR is a quad wavelength unit)  

Press    to enter the Menu mode. 

Use the Scroll Wheel to highlight the   in the icon list. 

Press  to cycle to the desired wavelength.  The OTDR will start a scan at the parameters displayed.   

    If approximate fiber length is not known:  

Press the  button after selecting the wavelength, (Press  on Range Finder) the Auto Test feature will 

start and set an appropriate pulse width and range automatically.  

If approximate fiber length is known: 

Press  and scroll to:     

 Press  to cycle through the averaging times of - R/T for real-time, Short for a 10 second   

          average time or Long for a 5 minute averaging time. 

 

 Press  to cycle through the pulse width - select 2m for fibers up to 4 kilometers, 10m for fiber 

           up to 16 kilometers, 100m for fibers up to 64 kilometers or 1k for fibers up to 240 kilometers.  

  

 Press   to toggle between to available range settings. 

 

Press  to exit the menu mode. 

To manually start a scan:   Press   while the unit is idle. 

To stop a scan:      Press   while the unit is scanning. 

To view the Event table:    Press   to enter Menu mode and use    

      the Scroll Wheel to highlight the Show     

      Event soft key and press the  button to    

      change to  the event analysis mode.   
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2.0 Loss Test Set Quick Start Guide 
 

Press  to turn on the OTDR.   

Use the Scroll Wheel to highlight the LTS function icon and press .  

Connect a properly prepared reference cord to the power meter port and the light source port.  (If the unit is a 

quad wavelength unit, ensure the proper port is connected) 

Press  and use the Scroll Wheel to highlight the Source soft key at the top left of the display.   

Press  to energize the first wavelength. Once stabilized, use the Scroll Wheel to highlight the  icon on 

the right side of the display.  Press  to set the reference for that wavelength.  If a second wave length is 

going to be tested, scroll back to the Source soft key and press  to cycle to the next desired wavelength and 

repeat the step to set the reference.  

Press    to exit the Menu mode. 

     
 
 

 
 
 
 
 
 

 
 
 

To conduct an Auto Test 

Note: Setting a reference in Auto Test mode is not 

necessary.  The source is modulated and a Reference of 

-3dBm (-6dBm-1625) is assumed. 

Connect fiber to be tested, press the  button and the 

light source will cycle to test each wavelength, the power 

meter will read the signal and hold test in temporary 

memory until the   button is pressed and the test is 

stored into the memory location indicated at the bottom 

left corner of the display.   

Ensure that the unit has cycled through all the desired 

wavelengths prior to pressing the select button.  

Auto Test will be displayed at the bottom of the display to 

indicate the Auto Test Mode.  

To conduct a Manual Test 

If using the OTDR as the light source, perform 

reference procedure as above and place fiber 

under test in line between the reference cord 

and the power meter port.   

Ensure you are in Menu mode and Scroll to 

Source soft key.   

Press  to cycle through the wavelengths 

and choose the wavelength to be tested. 

Press  to exit Menu mode. 

Press select to store the measurement to the 

location indicated in the bottom left of the 

display. 
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3.0 Introduction 
 

The Terahertz Technologies Inc. OTDR is the newest in the line of low cost portable Optical Time Domain 
Reflectometers with the core functions required to measure optical fiber from one end during installation, repair 
and verification. The Advanced OTDR is equipped with a 4” TFT color graphic presentation of fiber loss vs. 
distance, with Dual and Quad Laser sources.  The Advanced OTDR is packaged in a rugged aluminum housing 
which is further protected with a rubberized boot.  All controls are accessible via an 7 key weatherproof 
membrane with a capacitive touch/scroll wheel, offering simple, straightforward functionality.  
The Precision Rate Optic OTDR is capable of measuring 2 point loss, splice loss, LSA splice loss,  loss per/km 
and event ORL. The singlemode and multimode output ports use high power, 850, 1300, 1310, 1490, 1550 or 
1625 nm pulsed laser sources. The backscatter receiver uses a temperature compensated avalanche photodiode 
for reliable, stable performance in fiber links from tens of meters to over 240Km. A high-speed microprocessor, 
provides the N-point averaging function and control for as little as 1/2 second Real Time update rates.  
 
The TTI OTDR is available with an Auto-Wavelength Switching Power Meter.  The power meter is calibrated at 
the 850,1300,1310,1490,1550 and 1625nm, with storage of up to 10,000 power meter tests.  The Advanced 
OTDR software incorporates a feature to supply loss measurement reports and a real-time graph. 
 
The color TFT LCD display provides a powerful yet simple set of fiber parameters and control indications to view 
an entire fiber link or zoom in and analyze a splicing point or defect in the fiber. The display shows all or just the 
desired loss information. The fiber loss vs. distance in its central graph is large with easily manipulated cursors. 
The scales are automatically updated for expansion modes and with position changes of the A and B cursors. 
Individual and dual cursor measurements are displayed as well as important instrument parameters such as Index 
of Refraction, pulse width, wavelength, range, scanning speed, and a battery gauge.  
 
The 7 key panel provides simple straightforward commands to take a scan, make measurements or navigate the 
soft-key and Icon menus. A new scan is accomplished as easily as pressing the Scan button, within 1/4 second 
fiber trace data is accessible. With the use of the Auto Test button the OTDR can automatically adjust for an 
unknown fiber length (Range Finder Mode) or test a large number of fibers at 2 wavelengths, store the test and 
display the two test with just the press of just one button. (Construction Mode) The soft-key menus are navigated 
pressing the menu button and scrolling to the soft key bar located at the top of the display.  Instrument setup is 
easily accomplished with the use of the Icon menu located down the right-hand side of the display when the Menu 
button is press and the unit is in Menu Mode.   
 
The Advanced OTDR also supports the VP-100 Video Probe and displays a digital image of the connector end 
face that can be zoomed and centered on the display.  The image can also be stored for later review or printed 
with trace documentation. 
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4.0 Preparation for Use 
 
4.1 Inspection 

Before shipment, this instrument has been inspected and found to be in perfect working order and free of defects. 
The shipping carton contains the following: 

 
 

 

 

 
4.2 Identification/Configuration 

The instrument’s Model, Part Number, Serial Number, Date of Manufacture and 
Configuration are indicated on a label located on the bottom plate of the unit. The 
instrument’s history is filed at the factory by part number and serial number.  
                

                                                Fig  4.1 

4.3 Power Requirements                      

The instrument is equipped with a 100-240V-0.4A input universal battery charger with 13.6V, 0.75A, center 
positive output AC/DC charger that is supplied with interchangeable mains for US, Great Brittan, Europe and 
Australia which recharges the unit’s internal NiMH batteries (8 - AA, 2000mA hours).   Depending on usage, fully 
charged battery pack will typically enable 8 to 10 hrs. of use. Typical fully discharged batteries require 6 - 8 hours 
of recharging. 
 

Battery replacement is not recommended however if you must replace the batteries follow these procedures.  
Carefully remove unit from protective boot and remove the two screws from top plate and bottom plate that retain 
the back cover. Carefully remove back cover and remove the two screws that hold the battery covers in place.  
Replace only with 8 AA NiMH 2000mAh batteries.  If you install NiMH batteries that are dead or less than 1 volt 
each, charge these batteries for one (1) hour before using the Precision Rate Optics OTDR. For maintenance, 
batteries require a monthly periodic recharge. 
 

 
 
 
 
 
 
 

4.4 Laser Safety 
The OTDR has been configured with laser diodes having central wavelengths of 850nm, 1300nm, 1310nm, 1490,  
1550 or 1625nm. The unit has been designed to comply with 21 CFR (Code of Federal Regulations) 1040.10 and 
1040.11, for Class I emission limits. Although the CDRH does not consider Class 1 levels to be hazardous, we 
suggest limiting exposure by not looking directly into the laser aperture. Also, do not under any circumstance 
view or inspect the laser output fibers, connectors or the fiber under test through collimating or focusing optics 
unless the unit is turned off, batteries are removed and power adapter is disconnected.    
 

The VFL is equipped with a 650nm Class II laser. 
 

 
  

  
 
 
 

 
 
 
 

OTDR, with protective boot and 8-AA NiMH batteries installed Universal AC/DC charger with interchangeable mains 

CD with Windows™ compatible software USB cable 

Set of interchangeable adapters, ST/SC and FC Adapters for 
each OTDR port and for the Power Meter Port 

WARNING: To Prevent Fire or Shock Hazard: Do not install other battery types; Do not use the charger 
without the batteries installed; Do not expose the battery charger to rain or excessive 
moisture; Do not use the AC adapter when there are signs of damage to the enclosure or 
cord; Ensure that you are using the correct charger for the local line voltage. Do not use any 
other charger than the one provided with this instrument.  Any other condition will void the 
warranty.   

WARNING:  Never clean or look directly into the fiber optic connector or the end of fiber attached to the 
OTDR or VFL unit while they are energized, to do so will expose the user to laser radiation 
and could result in personal injury or instrument damage.

WARNING:   Before connecting to a patch cord or fiber under test, be certain the fiber has no active 
optical sources or instruments connected to the other end. Skin or eye damage could result 
from other high power sources e.g. EDFAs, or instrument damage could occur voiding the 
warranty. 
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5.0 FTE-7500A Description  
 
5.1 Mechanical Description 
 Enclosure 

The Precision Rate Optics OTDR is packaged in a rugged aluminum housing which is further protected with a 
rubberized boot.  Although the front panel is weather resistant, care must be taken to avoid liquids and 
contaminants around the fragile optical, electrical connectors, and the glass display. Use a mild cleaning agent 
and damp soft cloth to clean the panels and the outside case. See the maintenance section to clean the optical 
connector. NEVER open the instrument for cleaning. Return to the factory for servicing if necessary. 

 
Packaging 
The instrument is shipped in a protective cardboard container, universal charger with interchangeable mains, 
FC/ST and SC interchangeable fiber adapters, USB Cable and a CD with Windows™ compatible software.  Save 
the protective packaging for storage and shipment.  

 
5.2   Physical Description    
 

 
  
 
 

             
 
  
      
       
                                                                                                
 
 
 
 Power Jack Port 

100-240V-0.4A center positive input, 13.6V, 0.75A, output AC/DC charger port. 
  
 

 
 
 
 
 
 
 
 Video Probe Port 
 Eight Pin DIN connector for use with TTI’s VP-100 Video Probe. 
 
 USB Flash Drive Port 

Located on the bottom panel is the USB Flash Drive port.  Files may be downloaded to or uploaded from the 
external memory device.  Screen Shots are stored directly to the USB flash drive.  
 

 
 
 
 
  

 

USB/PC Port  

Located on the bottom panel is the USB/PC port which is used to connect the OTDR with a computer for 
downloading stored data and for operation of the remote VI application, with the supplied Windows™ compatible 
software.  

Bottom Panel 

USB 
Flash 

Power 
Jack 

Video Probe
Port 

USB 
PC 

Note:  When uploading files from a Flash Drive, the characteristics of the file must be supported by 
the OTDR being used.  For example: the OTDR must support the wavelength of the trace file 
from the flash drive.  MM traces cannot be viewed on an OTDR that only supports SM 

Note:   Do Not Remove USB Flash Drive While Accessing.

WARNING:     To Prevent Fire or Shock Hazard: Do not install other battery types; Do not use the charger 
without the batteries installed; Do not expose the battery charger to rain or excessive 
moisture; Do not use the AC adapter when there are signs of damage to the enclosure or 
cord; Ensure that you are using the correct charger for the local line voltage. Do not use any 
other charger than the one provided with this instrument.  Any other condition will void the 
warranty.   

Fig 5.1
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Physical Description   (Continued) 
 
 
 
 
 

 

 
  
 
 
  
                    
        
         
 
 VFL Port 

The Visible Fault Locator (VFL) port is a 2.5mm universal port with a 650nm visible laser.  
  

 
 
 
 
 
Power Meter Port 
The Power Meter Port is a 2.5mm universal port that accepts ST, FC and SC screw on adapters. 
 
OTDR Ports 
Depending on the model OTDR, there is either one or two OTDR Ports. There ports have 2.5mm interchangeable 
adapters that are held in place by m2 screws.  If the adapter is equipped with a chain adapter cap, the retaining 
screw 

 
 
 
 
 

   
 
 
   
 
 
          
 
 
 
  
 
 
 
 
 
 
  
   

 
 
 
 
 

Top Panel 

VFL 

MM 
OTDR Port

Power Meter  
Port  

(if installed) 

SM 
OTDR Port

Front View 

Display

Key Pad Scroll 
Wheel 

Charge 
Indicator 

Power 
Button 

WARNING:  Never clean or look directly into the fiber optic connector or the end of fiber attached to the 
OTDR or VFL unit while they are energized, to do so will expose the user to laser radiation 
and could result in personal injury or instrument damage.

Fig 5.2

Fig 5.3
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Front View   (Continued) 
 
Display 
This units is equipped with a 4” color TFT display 

 
 Charge Indicator 

The charge indicator glows bright when charging and dims when the batteries are fully charged. 
 

Key Pad 
The FTE7500 is equipped with a 7 button key pad.  For a full description of functions, please see sections 7.1 and 
10.1 

 
Scroll Wheel 
The scroll wheel is used to navigate through menus, move cursors and make adjustments to settings. 

 
 

Power Button 
The power button is used to power on and off the FTE7500A 

 
 
 
5.3 Home Screen  
  

Use the scroll wheel to highlight and then the select button to open the desired function. There is a Home icon or 
Home soft key in each application used to return to this Home Menu Page. 

 
 
 
 
    
     
     
 
   
     
 
  
 
 
     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Version 
Number 

Battery 
Level 

Indicator
 

Visual Fault 
Locator Function 

Video 
Scope

Loss Test Set 
Function 

General 
Instrument 

Setup 

Optical Time Domain 
Reflectometer  

Fig 5.4
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6.0 Settings and Features 
 

This section covers the settings and features that are universal in nature.   These settings are accessible by 
selecting the Settings Tab on the Home Screen.  Those setting or features that are limited to one function are 
covered in dedicated sections of this manual. 
 
When the desired changes have been made, scroll to the Home icon at the bottom of the screen and press select 
to return to the home Screen. 
 

6.1 Settings Tab 
   
  Date/Time 

The OTDR applies a date/time stamp to saved files.  The date and time are set at the factory with a MM/DD/YY 
date and 24 hour clock. To change the date and time, highlight the Date/Time settings tool and press the Select 
button.   A dialog box with the date and time will be displayed.  Use the scroll wheel to change each segment, use 
the Select button to move between segments and then to Redo option.  Use the scroll wheel to select Save, Redo 
or Cancel then press the Select button again to complete the process. 

 

Brightness 
The Display has a high and low brightness settings tool.  To toggle between the two settings, highlight Brightness 
feature and use the Select button to toggle between the two settings.  
 

Sound 
Button press and scroll sounds may be turned on or off as desires.  To turn sound on and off, highlight the Sound 
settings tool and use the Select button to toggle the sound on and off.   
 

Power Save 
The Precision Rate Optics OTDR incorporates a Power save feature that allows for maximum utilization of the 
battery life. If set to ON, the unit keeps track of the keypad activity and if no key presses are detected for a period 
of approximately 15 minutes, the unit will automatically turn itself off, storing the current mode settings. To set this 
feature, highlight the Power Save settings tool and press the Select button to toggle the feature on or off.   
 
 
Communications Baud Rate  
It may be necessary to set a com port speed for communication with a computer.  To set the baud rate, highlight 
the COM Baud Rate settings tool, press the Select button and a dialog with the available settings will be 
displayed.  Use the scroll wheel to select baud rates from 115k to 892k.  Press the Select button again to 
complete the process 
 
Pass Code Protection 
The FTE-7500A may be protected from unauthorized use with a 4 digit pass code.  Enter the Tool Menu, scroll to 
the Pass code Protection settings tool and press the Select button.  Use the Scroll Wheel to set the first digit from 
0 to 9 and press Select. Continue until all four positions are entered.  Press Select on the last digit to move the 
focus to “Enter” or “Cancel”.  Press Select on “Enter” to complete the setting of the pass code or use the Scroll 
Wheel to highlight “Cancel” and press Select to abandon any changes.   
 

When the desired changes have been made, scroll to the Home icon at the bottom of the screen and press select 
to return to the home Screen. 
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6.2 Battery Level/Power Indicator 
The bottom right hand corner of the screen shows the battery level and charge indicator.  In the final hour of 
operation the battery will change to red. A warning indicator will sound a few minutes before the instrument 
automatically turns off.  
 
  
 
When the OTDR is plugged in to an AC power supply, the charge indicator will be illuminated. The charge 
indicator will dim when the batter is fully charged.  The battery level indicator section on the display (Fig 5.3) will 
either have a yellow lightning bolt overlaid on the indicator or an AC Plug alongside, indicating AC power.   

 
6.3 USB Ports 
 USB Flash Drive  

Located on the bottom panel is the USB Flash Drive port.  Files may be downloaded to or uploaded from the 
external memory device.  Screen Shots are stored directly to the USB flash drive.  
 

 
 
 
 
  

USB/PC  
Located on the bottom panel is the USB/PC port which is used to connect the OTDR with a computer for 
downloading stored data and for operation of the remote VI application, with the supplied Windows™ compatible 
software.  

 
6.4 Help Feature                

The Precision Rate Optics OTDR has an onboard help feature.  This feature is accessible in all functional modes 
accept the VFL.  While operating in any of these functions, press the Menu button, scroll to the Help Icon and 
press Select.  Scroll to the desired topic and press the Select button. Use the scroll wheel to move down the help 
page if necessary.  Press the Menu button to exit the help feature. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 

Note:   When uploading files from a Flash Drive, the characteristics of the file must be supported by 
the OTDR being used.  For example: the OTDR must support the wavelength of the trace file 
from the flash drive.  MM traces cannot be viewed on an OTDR that only supports SM 

Note:   Do Not Remove USB Flash Drive While Accessing.

Note:  Ensure the unit is turned off when plugging in the Battery Charger.
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7.0  OTDR Operation 
 
7.1 Key Pad  
 
 
   
 
 
 

 Power button, turns the unit On and Off. (Hold for 1 second) 
 

  
 

 This key will start a scan or stop the current scan.  
         

                                                                                                                         
      

              
 
 

This key starts the auto test/range finder and construction mode scans. The range finder checks test conditions 
and start a scan at the wavelength selected by the user but allows the OTDR to determine the pulse width and 
range parameters.  The AutoTest button is also used operate the construction mode.  The first time this button is 
selected in a user session, a dialog box will be displayed asking the user to choose between range finger and 
construction mode.  Holding this button down for greater than one second will bring the selection dialog back to 
the screen allowing the user to change the function of the button. 

 
 
 
 
 Toggles between the Trace Mode where the focus of the Scroll Wheel and the Select Button are on the active 
 cursor and the Menu mode where the Scroll Wheel moves through the Soft Key Menu and the Side Icon Bar.  
 
 
 

 
 
 Toggles between A and B as the active cursors. 

 
 

  
 

 Selects the Zoom level, each press increments through the levels of 1x, 2x, 4x, 8x, 16x and 32x. 
 

 
 
 
 

While in Trace Mode the Select button will move the "Active" cursor to the next event. While in Menu Mode, the 
Select button actuates highlighted item.  

    
           

   
 
 

 While in Trace/Graph Mode the capacitive scroll wheel moves the A and B cursors.  While in Menu Mode it  
 highlights soft keys and icons and while in Table Mode it highlights files and events. 
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7.2 OTDR Display  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
    
 
 
 
 
 
 
 
 
 
 
 Trace Measurements 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
          
 
  Trace Parameters 
 
 
 
 
 
 
 
 
 
 
 
 
  

Trace Display  

Zoom Bar 

Parameter Settings 
See Fig 7.4 for more detail 

Measurements Area 
See Fig 7.3 for more detail 

“B” Cursors 

Zoom Status 
and  

Grid Values 

“A” Cursors 

Battery 
Status 

Fig 7.2

Wavelength setting  

Averaging Mode 

Pulse Width Setting   

Range Setting    

Fig 7.4

Index of 
Refraction 

“A” Cursor 
Splice loss 

“B” Cursor 
Splice loss 

“A to B” 
Distance     

“A to B” 
Loss 

dB Loss Per 
Unit of Measure 

Fig 7.3
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7.2 OTDR Display (continued) 
 

 
OTDR Display with Menu Open 

 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

7.3  OTDR Tools Menu  
 

Below is a list of the settings available through the Tools Menu in the OTDR mode.  Press the Menu button to 
open the Menu mode, scroll to the Tools icon and press the Select button.  Scroll to the desired setting and press 
Select to open. 
 
 

 Resolution  
The resolution tool should be highlighted. Use the Select button to toggle between Low and High.   This resolution 
feature affects the ranges of 4km and 16km.  At low resolution 4km range, data points are ¼ meter apart and at 
high resolution, the data points are 1/8 meter apart.  At 16km range, the low resolution date points are 1 meter 
apart and at high resolution the data points are 1/8 meter apart. 

 

Unit of Measure  
The distance unit of measure may be either displayed in Kilometer (Km), Kilo feet (Kf) or Mile(Mi).  Scroll to Unit 
of Measure icon and use the Select button to toggle between Km, Kf or Mi. Press the Menu button to return to the 
trace display. 

 

Cursor Lock  
The cursors may be lock for accurate measurements.  To lock the cursors press the Menu button, scroll to the 
Tools icon and press the Select button.  Scroll to the Cursor Lock icon and press Select to toggle the lock cursor 
mode on and off.  In the lock cursor mode, with the A cursor as the active cursor, both A and B cursors move and 
with the B cursor as the active cursor, the B cursor will move independently in order to set the distance between 
the two cursors.  

 
 
 
 
 
 
 
 
 

Soft Keys 

Menu Icons

Fig 7.5
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OTDR Tools Menu (continued) 

 
Screen Shot 
The FTE-7500A OTDR is equipped with a Screen Shot tool. This feature writes files directly to the flash drive.  To 
write a .bmp to the flash drive, highlight the Screenshot tool.  Press the Select button, the display will revert to the 
previous screen and progress will be shown by the inverse color pattern progressing from the bottom to the top of 
the screen. The process is complete when the display returns to the normal color. The file name will be 
hhmmss.bmp, where h = hour, m = minute and s = second.    If no flash drive is detected, an error message will 
be displayed.   
 
 
 
  

  
 
 
 
 

Set Viewable Measurements 
The FTE7500A allows the user to set which loss measurements that will be displayed.  The loss measurements 
seen are splice loss for  both cursors, dB value between cursors, distance between cursors and dB per unit of 
measure.  If any of these measurements are not of importance for a Series of test, one or more may be turned off 
for ease of viewing.  To accomplish this, highlight Set Viewable Measurements icon and press Select.  A box will 
be drawn around the splice loss measurements. Use the Scroll wheel to cycle the measurement between Splice 
Loss, LSA Splice Loss or off.  Press Select to move to A-B Loss and distance.  Again use the Scroll Wheel to turn 
these settings on or off.  Press Select again to move to the dB/KM (KF) and use the Scroll Wheel to turn this 
value on or off.  Press the Menu button at any time to exit this feature.  

  
 Set Wavelength Filter 

Set wavelength filter allows the user to disable unwanted wavelengths, and to set the operational wavelengths in 
the Construction mode. For Example: if the OTDR is a quad wavelength version and only singlemode fiber is 
being tested, the user may want to disable (shut off) the multimode wavelengths to eliminate having to cycle 
through 850nm and 1300nm is only 1310nm and 1550nm are being used.  This is very important for the 
construction mode where the OTDR may be set to conduct two scans, display and save the scans with the touch 
of just one button.  Grayed out wavelengths are turned off. To select wavelengths, scroll to highlight the 
wavelength and press the Select Button. To complete the process, scroll to Save and press select.  Press Menu 
again to close the Tools dialogue box. 
 
 
 
 

 
 
 
Enter Calibration  

 This tool is for factory use. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Note:   Do Not Remove USB Flash Drive While Accessing.

Note:   This method is not used with the Video Probe. The video probe has its own method of 
saving & copying files. 

Note:  There are two uses for the Lambda icon with the OTDR.  In the tools menu it is use to disable 
and enable each wavelength for use.  In the regular use of the OTDR, in main menu list, it is 
used to change wavelength being tested.   
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7.4  Auto Test       
  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Range Finder 
This is a useful feature when the approximate length of the fiber to be tested is unknown.  The Range Finder 
feature tests at the wavelength selected by the user.  To set the wavelength, press the Menu button, scroll to the 
Lambda icon and use the Select button to cycle to the desired wavelength.  Press the Autotest button, the unit will 
set the average time to short, starts a scan and flashes Auto in the pulse width and range parameters.  When 
Auto stops flashing the unit has set the pulse width and range, then completes the test and displays the trace.    

  
 Construction Mode 
 This is useful when a large number of fibers need to be tested with the same settings at multiple wavelengths.   

To operate in Construction mode, set the Autotest button to construction mode in the manner described above.  
The Construction Mode tests up to two wavelengths at one time, displays the two traces and saves the traces to 
the next two available storage locations.   
 

 
Follow these procedures to test in Construction mode: 
 
Set The Wavelengths: 
Set the wavelengths to be tested by pressing the Menu button, scrolling to the Tools icon and pressing Select.  
Scroll to the Set Wavelength Filter tool and press Select.  Grayed out wavelengths are turned off. The 
wavelengths in black text are active. To select wavelengths, scroll to highlight the wavelength and press the 
Select Button. To complete the process, scroll to Save and press select.  Press Menu again to close the Tools 
dialogue box. 
  
Set Test Parameters: 
Check the Average Time, Pulse Width and Range to ensure they are set properly.  Refer to section 7.4 for 
instructions on setting these parameters.  
 
Note: Real Time is not recommended as an averaging time for Construction mode.   
 
Set The File Name: 
It is necessary to set the base file name prior to starting the test.  To establish the file name, press the Menu 
button and scroll to the File Management icon and press Select.  Scroll to an empty file location and press Select.  
Name the file by using the scroll wheel to display the desired letter or number and press Select to move to the 
next Character.  Do not press select to enter the last character.  Once it is displayed, press the Menu button and 
Save Changes soft key will be highlight, press Select or use the Scroll Wheel to select Discard Changes and 
press Select.  All future files will use the new base file name until it is change.  The file that was just created may 
be deleted if desire by following the procedures in section 10.9. 
 
 
 
 

WARNING:   Before connecting to a patch cord or fiber under test, be certain the fiber has no active  
  optical sources or instruments connected to the other end. Skin or eye damage could result 
  from other high power sources e.g. EDFAs, or instrument damage could occur voiding the 
  warranty. 

WARNING:   Clean connector thoroughly prior to connection to the appropriate port of the OTDR.  Failure 
to ensure the connectors used with the OTDR are properly cleaned can result in poor launch 
conditions at the minimum or damage that requires the unit be returned to the factory for 
repair. 

Note:  The first time Autotest is press upon power-up, a dialog box will be display to set the function of the 
button. Use the scroll wheel to move between the Range Finder and Construction Mode. Press the 
Select button once the desired function is highlighted.  To change the function once set in a user 
session, press and hold the Autotest button and the dialogue box will be displayed again.
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Auto Test (continued) 
 
Set Default Notes: 
To enter default notes for trace files, enter the File management as above and scroll to any empty location.  Press 
the Menu button, scroll to the Notes soft key and press Select.  The first Character of the note box is highlighted.  
Use the Scroll Wheel to select the desired character and press select.  Continue on until the note is complete.  To 
erase the characters and move forward, use the “blank”.  To quickly return to the beginning of a note, press the 
Menu button and then the Select button on the Notes soft key.  To exit the Notes box, press the Menu button.  
This note will now be the default note for all traces until it is changed or removed.  To remove notes, Press Select 
on the “blank” character until all characters have been removed. 
 
Conduct The Tests: 
Connect a fiber to the proper test port and press the Autotest button.  The OTDR will conduct the test at the first 
wavelength and store the trace in temporary memory using the base file name given, with default notes attached. 
The second wavelength is then started and once complete the traces stored to memory, and then both traces are 
displayed for review.  
 
Disconnect the fiber, connect the next fiber and press Autotest.  The two tests will be completed stored and 
displayed.  Continue on until all fibers are tested.   

 
 

 
7.5  Manual Scan Setting 
 After powering on the OTDR, Enter the menu mode by pressing the Menu button and scroll to the parameter keys 
 to set all the necessary parameters to the appropriate values.   
  
 These parameters include:   

 
Resolution  
 
Enter the Menu mode, scroll to highlight Tools icon and press Select.  The resolution tool should be highlighted. 
Use the Select button to toggle between Low and High.   This resolution feature affects the ranges of 4km and 
16km.  At low resolution 4km range, data points are ¼ meter apart and at high resolution, the data points are 1/8 
meter apart.  At 16km range, the low resolution date points are 1 meter apart and at high resolution the data point 
are1/8 meter apart.  
  
 
 
 
 
 
 
 
 
 
 

	
 

 
IOR 
It is necessary to have the Index of Refraction set as close as possible to the actual IOR of the fiber.  If this is 
unknown it is best to use the default setting on the OTDR.  To change the IOR, highlight the IOR icon and press 
the Select button.  Use the Scroll wheel to change the IOR value.  When the desired value is reached, press the 
select button again and the OTDR will prompt the user to save or cancel the changes.  Use the scroll Wheel to 
highlight desired action and press the Select button.   

 
 Wavelength 
 Use the scroll wheel to highlight the Lambda key, press select to cycle through the available wavelengths.   
 

Note:    The resolution setting does affect speed and internal storage capability.  At the 16km range, high 
resolution vs. low resolution, the trace could take up to 8 times longer to complete and trace file sizes 
could be up to 8 times larger, decreasing file storage capability.  High resolution mode at the 4km 
range could cause the trace time to double as well as the file size.  To determine the amount of trace 
memory available, enter file management, scroll to the view tab and select “Stats” from the drop 
down menu.  This will show the number of traces saved and the number of traces that can still be 
saved in the internal memory.    

Note:   To determine the amount of trace memory available, enter file management, scroll to the view tab 
and select “Stats” from the drop down menu.  This will show the number of traces saved and the 
number of traces that can still be saved in the internal memory.    
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AVG  
 Use the scroll wheel to highlight the Average (AVG) icon and use Select button to cycle through, Real-time 
 averaging, with a up to 2 pps  refresh rate,  Short average (~30 seconds) or long average (~10 minutes).   
 Changing this setting will also initiate a scan. 
 

Pulse Width 
Use the scroll wheel to highlight the PW icon and use the Select button to cycle through the available pulse widths 
for the selected range. The pulse widths are listed in the table below. 
 
Range 
Use the scroll wheel to highlight the RNG icon and use the Select button to choose the desired range.  Available 
ranges are listed in the table below.   

 

7.6  Viewing  Traces 
  

Zoom 
There are five zoom levels, 1x, 2x, 4x, 8x, 16x and 32x.  The current level is indicated in the bottom right corner of 
the display with the values per division.  Press the Zoom button to cycle through the zoom levels.  When in the 
Menu mode, pressing select while the Zoom soft key is highlighted will also cycle through the zoom levels. 

 
 
    
  

Zoom Bar 
The bottom most portion of the trace is a Zoom Bar.  This represents the entire range of the trace being viewed.  
The green bar within the area represents the amount of the trace that is being viewed whiled the zoom function.  
While in Zoom level 1x the green bar will fill the zoom bar area meaning the entire range of the trace can be 
viewed and in Zoom level 2 the green bar will fill only half of the zoom bar area, meaning half of the entire range 
of the trace can be viewed. As the zoom levels increase, the green zoom bar will  decrease in size to indicate the 
amount of the trace that can be views at one time.  As a cursor is moved with the Scroll Wheel, the green zoom 
bar moves to indicate what portion of the trace is being seen. For example, if the  green bar is to the left of the 
zoom Area, the beginning portion of the trace is being viewed and if the green bar is to the right of the zoom Area, 
the end of the trace is being viewed.   

  
 Cursor movement  
 The active cursor is shown as a solid line while the inactive cursor is a dashed line.  When in the Menu mode an 
 “A” or “B” will be displayed next to the Cursor soft key as in indication   Press the A/B button to toggle between the 
 cursors. When in the Menu mode, pressing select while the Cursor soft key is highlighted will also toggle the 
 active cursor. 

 
 
 
 
 
Cursor Lock  
The cursors may be lock for accurate measurements.  To lock the cursors press the Menu button, scroll to the 
Tools icon and press the Select button.  Scroll to the Cursor Lock icon and press Select to toggle the lock cursor 
mode on and off.  In the lock cursor mode, with the A cursor as the active cursor, both A and B cursors move and 
with the B cursor as the active cursor, the B cursor will move independently in order to set the distance between 
the two cursors.  

 Pulse Width 

R
an

g
e 

 5ns 10ns 30ns 100ns 300ns 1μs 3μs 10μs 20μs 

1km          
4km          
16km          
64km          
256km          

Note:   The values per division change with each change of the zoom level and are indicated in the 
 lower right corner of the display 

Note: To quickly move the active cursor to the next event, press the Select button while the unit is 
in the trace view mode. 
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7.7  Unit of Measure 

The distance unit of measure may be either displayed in Kilometer (Km), Kilo feet (Kf) or Mile(Mi).  To change the 
setting,   enter the menu mode, scroll to highlight the Tools icon and press the Select button.  Scroll to Unit of 
Measure icon and use the Select button to toggle between Km, Kf or Mi. Press the Menu button to return to the 
trace display. 
 

7.8 Loss Measurements   
Set Viewable Measurements 
The Precision Rate Optics OTDR allows the user to set which loss measurements will be displayed.  The loss 
measurements seen are splice loss for both cursors, dB value between cursors, distance between cursors and dB 
per Km or Kf.  If any of these measurements are not of importance for a Series of test, one or more may be turned 
of for ease of viewing.  To accomplish this, highlight Set Viewable Measurements icon and press Select.  A box 
will be drawn around the splice loss measurements. Use the Scroll wheel to cycle the measurement between 
Splice Loss, LSA Splice Loss or off.  Press Select to move to A-B Loss and distance.  Again use the Scroll Wheel 
to turn these settings on or off.  Press Select again to move to the dB/KM (KF) and use the Scroll Wheel to turn 
this value on or off.  Press the Menu button at any time to exit this feature.  

  
 Loss Mode Definitions 
 

 2 Point loss method takes the difference in vertical height between where the A and B cursors cross the 
trace to determine the amount of loss in that section of fiber. 

 The dB/Km (dB/Kf) loss method takes the 2 Point loss in dB and divides by the distance between the 
cursors in Kilometers (Kilo feet). For accurate dB/Km (dB/Kf) loss measurements, the two cursors must 
be on level backscatter points at least 100m apart (NA will be shown for distances that are too short). 

 Splice Loss method is meant to be used in noisy environments when it is difficult to attain an LSA area 
that lays flat on the back scatter before and after the cursor.  See section 7.8 - Setting Splice Loss 
Measurement Areas. This method takes an average of the selected points before and after the active 
cursor and uses this average to make a good estimation of the event loss.  This is an estimation but this 
method may be more accurate than LSA Splice Loss method in noisy environments. 

 Least Squares Approximation (LSA) Splice loss method gives the user a visual aid in setting splice loss 
areas. The splice loss lines must be set to overlay the backscatter of a trace without over lapping any 
other events. The LSA areas are set properly when the LSA visualization lines overlay the back scatter 
sections of the trace before and after the event.  This method can be more accurate by affording the 
ability to see the slope of the splice loss areas, however: it can also supply a reading with greater error if 
not used properly. Please see Fig 7.3, 7.4 and 7.5 for examples of LSA settings. In Noisy environments 
the LSA Lines will have an exaggerated movement making the Basic Splice Loss Measurement 
potentially more accurate.   

 
 

7.9 Setting Splice Loss Measurement Areas  
 

The splice loss measurement areas around the cursors are adjustable.  This feature is used for both Basic Splice 
Loss and LSA Splice Loss. To access this feature, press the Menu button and scroll to the SPL icon. An arrow will 
be displayed above the point of the measurement area to be adjusted with the Scroll Wheel. There are three 
points that may be adjusted.  The left hand most point of the measurement area before the cursor and the left or 
right hand point of the area after the cursor. 
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Setting Splice Loss Measurement Areas (Continued) 

   
LSA Set Too Early 
 
 
 
 
 
 
 
 

     
                     

  
 

LSA Set Too Late 
 
 
 
 
 
 
 
 
   
   
    
 

    
Proper LSA Setting 

 
 
 
 
 
 
 
 
 
                      
 

 
7.10 Quick Save/Recall 

 
Quick Save 
To use quick save, press the Menu button, scroll to the Save soft key and press the Select button.  The trace will 
be saved to the storage location shown. The file will be stored with the same base file name as the last save 
stored trace.  If the storage location indicated already contains a file, the user will be prompted to either 
“Overwrite” the location, Save to the “Next” available location or “Cancel” the action.  Scroll to the desired action 
and press Select.  The storage location will increment accordingly.   
 
 
 
 
 
Quick Recall 
To quickly recall a trace, press Menu, scroll to the Recall soft key and press the Select button to display the trace 
that is saved in the memory location indicated and the next memory location with a trace will be displayed.      
 

The LSA area and cursor are 
set too late. The left most green 
LSA indicator line is not over 
laying the back scatter of the 
trace   
   

The LSA area and cursor are 
set too early. The right most 
green LSA indicator line is not 
over laying the back scatter of 
the trace properly.   

The LSA area and cursor are 
set properly.  The green LSA 
indicator line is over laying the 
back scatter of the trace 
properly.   

Fig 7.6 

Fig 7.7 

Fig 7.8 

Note:   There are sample traces stored on the OTDR at the factory.  These traces are saved in the 
with the base file name of default. 
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8. 0  Event Analysis 
 
 

 
 
 
 
 
8.1 Enter Event Analysis Mode 
  
 To open the event analysis table, press the Menu button, scroll to highlight Show Event soft key and press the 
 Select button.  Use the Scroll Wheel to move through the events.  If the Select button is pressed while an event is 
 highlighted, The OTDR will revert to the  Trace Screen with the active cursor positioned at the selected event.  An 
 alternative method to return to the trace view is to press the Menu button, scroll to the Show Trace soft key 
 and press the Select button. 
 
8.2 Event Analysis Table  
    

 
     
 
 
       
   
  
 
   
       
  
      
    
 
 
       
      
      
      
             
                   

  
 
      

Fig 8.1 
8.3  Field Descriptions 

 
 # (Event Number)  
 Indicates the events in sequence, higher numbers are further distances from the OTDR. “E”, which is always 
 displayed in the bottom row is the event determined to be the End of Fiber (EOF). 
 
 P/F (Pass/Fail) 
 Pass/Fail, if any one of the thresholds are not met for and event, the P/F column will display a red X.  The 
 parameter that failed will also be displayed in red.  If all the parameters are met, a green check mark will be 
 displayed. 

 
KM (Event Location) 

 Event Location, Km for Kilometer or KF for Kilo-feet or Mi for Mile.  This is the distance/location that the  event 
occurs in the respective unit of measure.   

 

Soft keys 

dB/KM  
or(Kf)  

Event 
Loss 

Event 
Type 

Page# 
of Total 
Pages 

Scroll Bar

2 Point  
Loss 

Event 
Location

Pass/Fail 

Event 
Number 

End of 
Fiber 

Parameter 
Settings of 

Trace  

NOTE:   When using the event table, it is necessary to keep in mind that event analysis provides 
approximate  loss and distance measurements to quickly assist in network evaluation.  
Automatic detection results are not guaranteed and have their limits, possibly causing 
erroneous readings or detection failure. User interaction by interfacing with the trace display 
is recommended for final qualitative and quantitative analysis 
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 Field Descriptions (Continued) 
  
 SPLICE (Event Loss) 
 Event Loss, where a positive number is the amount of loss and a negative number would be indicating a gain. 
 This is a settable threshold for the Pass/Fail feature. 
 
 2POINT (2 Point Loss) 
 2 Point Loss, which is measured from the end of the dead zone of the previous event to the beginning of current 
 event.  
 
 DB/KM  (dB Loss Per Km/Kf) 
 dB per Kilometer if in KM unit of measure and DB/KF if in Kilo-Feet unit of measure.  This is the calculated loss 
 per Km or Kf from the end of the dead zone of the previous event to the beginning of the current event.  
 
 TYPE (Event Type/ORL) 
 Event Type is the type of event or the ORL measurement.  If the event is no reflection, “splc” will be displayed and 
 if the event contains a reflection, the ORL value will be displayed.  This is a settable threshold for  the Pass/Fail 
 feature 
 
 E  (End Event) 
 The bottom row of the table is the loss and distance information as it pertains to the entire fiber link.    KM column 
 is the end of fiber distance measurement, Splice column is not used, 2 Point is the measurement from the origin 
 (OTDR) to the determined end of fiber in the KM column. The dB/km column is that measurement for the entire 
 link and in the Type column Link will be displayed. 
 

Other Display Elements 
To the right of the table is a scroll bar which will be active if the amount of events exceeds one page and below 
the scroll bar is an indication of what page is display per number of pages.  Also on the Event Table display are 
the parameter settings for the current trace. 
 

8.3  Sensitivity Settings 
 

 There are three levels of sensitivity while in the event table.  The sensitivity is set via the Sense soft key. Press 
 the Menu button and Scroll Wheel to highlight the Sense key. Press the Select button to cycle through “Lo” (Low) 
 for event with loss as low as approximately 0.5dB,   “Me” (Medium) with events with loss down to approximately 
 0.2dB and “Hi”, for events with loss as low as approximately 0.1dB.  Medium and High sensitivity settings should 
 be used for high signal level, low noise, long pulse, averaged traces. 
 
8.4  Pass/Fail Settings 

 
Splice, ORL and Link are all settable thresholds for Pass/Fail purposes. To set the thresholds, press the Menu 
button, scroll to highlight the desired soft key, press the Select button and use the Scroll Wheel to reach the 
desired value.  Press Select button again to lock in the settings. If the trace fails any of the three thresholds, a red 
X will be displayed in the P/F column and the suspect threshold value will be displayed in red.   

 Examples: 
  Splice:  If a splice needs to be less then 1dB, set the threshold to <1.0.     
   If 1.0 would be accepted, set threshold to 1.01db.   
 
  ORL: If an ORL needs to be less then -50dB, set the threshold to <50.   
   If 50dB is acceptable, set the threshold to <49.   
 
  Link:   If the link loss needs to be less then 20dB, set the threshold to <20.      
   If 20db link loss is acceptable set the threshold to <21.   
 
  End:   This threshold setting is the first test to determine the end of fiber. If set to 3dB, the first   
   event that meets this threshold will be identified as the end of fiber.   
   

To return to trace view, press the Menu button, scroll to the Show Trace soft key and press the Select   
 button. 
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9.0  File Management  
 

9.1 Display 
 
 

 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
            

 
File Management Drop Down Menus 
 
 

 
 
 
 
 
         
 
9.2  Entering/Exiting File Management  

Press the Menu button, scroll to highlight the TRC (Disc) icon and press the Select button.  For each test/file 
saved, an indication of wavelength, range, pulse width and a time stamp are stored.   The file name can have up 
to 16 characters using the following; 0-9, A-Z, a-z, _ (underscore) or blank.  To close the File Management 
System, press the Menu button, scroll to highlight the File Tab, scroll to Exit and press Select.   

 
9.3 Saving a Trace          

There are two methods to save traces.  The first is the Quick Save method described in section 8.8.  The second 
method is to enter file management with a trace on the display, press the Menu button, scroll to the File 
Management icon and press Select.   Press the Menu button to the shift the focus of the scroll wheel to the file 
management tabs.  Highlight the File tab, press Select and with Save highlighted in the dropdown menu, press 
select again.  Use the scroll wheel to change the highlighted character.  With the desired character displayed, 
press Select to enter that character and the next character will be highlighted.  Continue until the desired file 
name is entered and press the Menu button.  Use the scroll wheel to highlight Cancel, Redo or Save and press 
Select.   
 

9.4 Renaming a Trace 
Highlight the file to be renamed using the scroll wheel.  Press the Menu button and scroll to highlight the Edit tab.  
Press Select and with Rename highlighted in the dropdown menu, press select again.  To leave a character 
unchanged, simply press Select on the highlighted character.  To change a character, use the scroll wheel to 
make the change and press select with the desired character displayed.  Continue until the name is entered, 
press the Menu button, scroll to select Save Changes or Discard Changes, and press Select.   

 
 
 
 

File Management 
Tabs 

See Fig 9.2 

Context 
Sensitive 

Help  

Default Notes 

Time Stamp 
Range

Wavelength
Pulse width

File Name

Fig 9.1

Fig 9.2
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9.5 Viewing Saved Trace 
To view a saved trace from internal memory, use the scroll wheel to highlight the desired trace and press the 
Select button.  The OTDR will revert to the trace view with the selected trace displayed and directly below the 
trace will be the trace name. “Load” located in the File dropdown menu may also be used to load a trace to the 
trace screen.  With the desired trace highlighted, press menu, scroll to the File tab, press select, use the scroll 
wheel to highlight Load and press Select. 
 

9.6  Dual Trace 
  
   
 

With a trace on the display, enter the file management, highlight the trace to be placed in the background, press 
the Menu button, scroll to the File tab highlighted, press Select, scroll to Dual on the dropdown menu and press 
select again.  Both traces will now be displayed.  The primary or first trace loaded is the black trace and the 
secondary trace is the green trace.  All values displayed are the values associated with the primary trace.  If the 
trace for the background does not have the same range or resolution as the main trace, a range mismatch 
message will be displayed.  Press the Select button to clear the message.   

 
 To exit the Dual Trace mode, start a new scan or open a new main trace from file management. 
 
9.7  Marking Traces for Mass Coping and Deleting 

Scroll to highlight the first trace to be copied or deleted.  Press the Menu button, scroll to the Mark tab and press 
Select.  To mark 1 or 2 files for mass copying, press the Select button and the highlighted trace will be displayed 
in red font.  Pressing select again will mark the highlighted trace and the next trace will be highlighted. (The 
highlighted file is not marked.)  Only those files in displayed in red are marked.  To mark a large number of files 
use the scroll wheel.  Scrolling down (clockwise) will mark a file and scrolling up (counter clockwise) will un-mark 
a file.  Files may be skipped by shutting off the marking feature, scrolling ahead and turning the feature back on.  
To do this, once the last trace of a section has been marked, press the Menu button, scroll to the next file to be 
marked, press Menu again, press Select or scroll to continue marking the files.  Once all the desired traces are 
marked they may be deleted or copied as necessary. 
 

9.8 Copying Traces 
 

 
 
 
 
 
 
 
 
 
NOTE:    Do Not Remove USB Flash Device While The OTDR Attempts To Read Or Write To That Port. 
 
Traces may be copied to the USB flash drive or to a PC for use with the certification software.  The Certification 
Software is required to copy trace files to a computer through the USB/PC Port.   With a trace highlighted or a 
group of traces marked, press the Menu button and scroll to the Edit tab, press Select, chose either Copy PC or 
Copy USB from the dropdown menu and press select.   

 
9.9  Deleting Traces 

Traces may be deleted from the internal memory or USB flash drive.  With a trace highlighted or group of trace 
marked, press the Menu button, scroll to the file tab, choose Delete from the dropdown menu with the scroll wheel 
and press Select.  Use the scroll wheel to highlight Cancel or Confirm Delete and press Select. 
 
 

 
 
 

NOTE:  Limit flash drives to 4 gigabytes.  It is suggested that new flash drive sticks be tested prior to 
use.  Save traces to the flash drive from the OTDR and test them on the computer with the 
supplied software to ensure they operate properly.   

NOTE:    Do Not Remove USB Flash Device While The OTDR Attempts To Read Or Write To That Port. 

Note:   To compare two traces, they must have the same range and resolution settings. 
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9.10 Adding Default Notes 
A note may be saved with a trace. With a file highlighted, entering a note will save that note for that one trace.      
With an empty file storage position highlighted, enter a note and this note will be stored with all traces until the 
note is changed or deleted.  To enter notes, while in the file management screen, press the Menu button, scroll to 
the Edit tab and press Select.  Use the scroll wheel to choose Notes from the dropdown menu and press Select.  
The first character of the notes field will be highlighted.  Use the scroll wheel to choose a character and press 
Select. To erase a character or enter a space, scroll back to the “blank” which is the first character available.   If a 
mistake is made, it may be best to exit the Note field by pressing the Menu button, and reenter the notes field 
from the Edit dropdown.  Once you have completed the note, press Menu to exit.   
 

 
9.11   Accessing Flash Drive  
 
 

 
To access the flash drive, while in file management, press the Menu Button and scroll to the View tab, press 
Select and choose USB Stick from the dropdown menu.    To return to the internal memory, press the Menu 
button, return to the View dropdown and choose Internal.   All of the Tab functions available for the internal 
memory are also available for the Flash drive. 
 

 
9.12 Internal Memory Statistics  
 

The amount of storage available in the onboard memory is found in the Internal Memory Statistics screen.  To 
view this screen; while in file management, press Menu, scroll to the View tab and select Stats from the dropdown 
menu. This will indicate the percentage of memory used and how many more traces of a specific range may be 
saved. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE:    Do Not Remove USB Flash Device While The OTDR Attempts To Read Or Write To That Port. 
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10.0 Loss Test Set Description 
 

10.1 Entering Loss Test Set Mode 
 
The LTS application is entered from the Home Menu.  Use the Scroll Wheel to highlight the LTS application Tab 
and press Select.  From the OTDR application, press the Menu button, scroll to the Exit Icon and press Select to 
return to the Home Menu.  When in the Scope application, Press the Menu button, scroll to highlight the Return 
soft key and press Select to return to the Home Menu.  

 
10.1  Key Pad Operation 
 
 

 
 

 
 

 
 

 
                 
 

 
 
 

 
                

  
 
 
 

 
 
 
 

 
Power button, turns the unit on and off.  
 
 

 
Resets any temporarily memory values before they  
have been stored with the select button.   
  
 
  
Starts the Auto Test function. The light source will be 
turned on and cycle through the wavelengths selected 
with the λ icon. 
  
 
  
 
Toggles between the Test mode and the Menu mode 
where the focus of the Scroll Wheel and the Select Button 
are on the soft keys and icons.  
 
 

 
Cycles through the power meter wavelengths selected 
with the λ Icon.  When in the File Selection Screen this 
key will toggle through save values for a particular storage 
position. 
 
 

 
Changes the display to the zoom screen where all stored 
test for a memory location are display. There can be up to 
4 test stored per location.   
 

 
 
The Select Button will store all measurements 
in the temporary memory to the storage position 
shown the lower left corner of the display while 
in the Test Mode and while in the Menu mode it 
will activate an icon item or soft key. 
 
 

         
 
Scroll Wheel 
When the Scroll Wheel is moved the File 
Selector screen is displayed for quick reference 
and if no key is press for 5 seconds, the display 
returns to the test mode. To return to test mode 
immediately, use the Scan button 
 
When in Menu mode, the Scroll Wheel moves 
through the Soft Keys and Icons. 

Fig 10.1
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10.3  LTS Displays    
 
 LTS Measurement Screen 
 
 
 
 
                                                             
 

 
         
 

 
 

           
                                  
 
                 
        

  
 
 

       
           

 
        
 
 
  

 
 
 
LTS File Storage Access Screen 
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PM Wavelength 

Next Storage 
Location 

Parameter Key

Icon Bar

Soft Keys 

Exit Button 

Fig 10.2
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 LTS Displays (continued) 

 
  

LTS Zoom Screen       
 
 
 
 

 
 
 
 
 
 
  
   
 
 
 
 
  
                                       
 
  
 
 
 
 
 

LTS Graph Screen    
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Fig 10.5
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10.4 Soft Keys Operation    
 Source 
 Enter the Menu mode and scroll to highlight the Source soft key.  Press the Select button to cycle through the 
 available wavelengths. (See Lambda/wavelength icon information below) The displayed source wavelength is the 
 active source.  Turn off all sources, by cycling to the “Off” position.  
 
 Power Meter 
 Enter the Menu mode and scroll to highlight the Power Meter soft key.  Press the Select button to  cycle through 
 the available wavelengths. (See Lambda/wavelength icon information below)  

 
Modulation 
There are four source modulation settings.  270 Hz, 1000Hz, 2000Hz and CW (constant wave).  To change the 
modulation setting, enter Menu mode and scroll Wheel to highlight the Modulation soft key.  Press the Select 
button to cycle through the modulation rates.   

 
10.5  Loss Test Set Icon List 
  
 Help 
 The Loss Test Set has an onboard help feature.  To access the help feature, enter the Menu, use the scroll 
 wheel to highlight the Question Mark Icon and press the Select button.  Scroll to the desired topic and press the 
 Select button.  Press the Menu button again to exit the help feature. 
  
 Delete 
 Deleting a stored loss measurement is accomplished in the File Selector mode.  (See LTS File Selector operation, 
 Section 11.4) To delete a measurement/s from a single memory location, while in the File Selector, select the 
 desired test to be deleted, press menu scroll to the Delete icon and press select  
 
 
 
  

To delete the all the memory locations at one time, follow the procedure above, however do so on and empty 
 location.  When the Delete icon is select on the empty location, a Confirm dialog with “Delete all files?” will be 
 displayed and the option to Delete or Cancel the action. Press the Select button with the desired action 
 highlighted.  
  
  
 
 
 
 Measurements may also be deleted in the Quick File Locator.  With the storage location selected, press the Menu 
 button, scroll to the Delete icon and press Select.  There is a time out on the Quick File Select.  If the display 
 reverts to the test mode, before the delete button is selected, the file will not be deleted.   
 
 Quick File Locator 
 To quickly move through the loss storage locations, enter the Menu mode, scroll to the TRC (disc) icon and press 

Select.  The Memory location at the bottom of the display will be highlighted.  Press the Select button to focus the 
highlighted area on just the 1000’s position.  Use the Scroll Wheel to make changes.  Press the Select button 
again to move the focus to the 100’s position and repeat this procedure until the desired storage location is found.  
Scrolling when all the digits are highlighted will move thought the positions one at a time as normal. Press the 
Menu button to return to Menu Mode. 

  
    
 
 
 
 
 
 
 

Note: There is not warning or confirmation necessary to delete one memory location. 

NOTE:  A loss measurement of (----) is not empty if there is a wavelength displayed to the right.  That 
would  be a null measurement).  An empty location is (----) with no wavelength displayed to 
the right. 
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Screen Shot 
The FTE-7500A OTDR is equipped with a Screen Shot tool. This feature writes files directly to the flash drive.  To 
write a .bmp to the flash drive, highlight the Screenshot tool.  Press the Select button, the display will revert to the 
previous screen and progress will be shown by the inverse color pattern progressing from the bottom to the top of 
the screen. The process is complete when the display returns to the normal color. The file name will be 
hhmmss.bmp, where h = hour, m = minute and s = second.    If no flash drive is detected, an error message will 
be displayed.   
 
 
 

 
 
  
  
 
 This feature takes an image of the screen and saves it to a flash drive,   
  

View Graph 
 Selecting the View (eye) icon will change to the Graph Mode.  For More information on the graph mode, see 

section 11.6.  To revert back to the normal power meter mode press Select again time with the View Icon 
highlighted.   

 
 Lambda (Wavelength Selection) 
 Highlighting and selecting the λ Icon will display the Wavelength Selection menu.  Use the scroll wheel to highlight 

the wavelengths to be select for use with the light source and power meter and press the Select button to toggle 
them off and on. The selected wavelengths will be the only wavelengths tested auto test and the only ones 
available when cycling through the light source and power meter soft keys.  Highlight “Save Selection” at the 
bottom of the menu and press the Select button to save the setting and return to the Loss Lest Set mode.   

 
File Download 
File Download is used to send the save Loss Test to a PC.  Once the FTE-7500A is connected to a computer with 
the certification software running, enter the menu mode and highlight the File Download icon.  When directed to 
do so, press the Select button to immediately start a download to the computer via the USB cable. Press the 
Menu button to return to the test mode. 

 
 Set Reference  
 This icon is used to set the reference for relative loss measurements. 
 
 dBm/dB  
 This icon is used to toggle the power meter from absolute power referenced by dBm and relative power 
 referenced by dB.  
 

Calibration  CAL 
 This tool is for factory use only. 
 
 Exiting Applications  
 To exit the OTDR and LTS applications, Press the Menu button, scroll to the Exit icon in the menu bar and press 
 Select.  This will return user to the Home Screen.   
 
 

 
 
 
 
 
 
 

Note:    Do Not Remove USB Flash Drive While Accessing.

Note:  This method is not used with the Video Probe. The video probe has its own method of saving 
& copying files. 
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11.0 Loss Test Set Operation  
 
11.1  Power Meter Measurements  
 Power Measurements 

With the FTE-7500A in Loss Test Set Mode.  Connect the fiber carrying the optical power to be measured to the 
Power Meter detector utilizing the appropriate adaptor. Select the power meter wavelength that matches the 
wavelength of the light being measured. The power reading will now indicate the optical power in units of dBm. 
The power will display an out-of-range condition indicated by a Series of four dashes on the display if the signal is 
greater than +5 or less than -77 dBm. CATV versions are available upon request. 
 
To save the power measurement to the storage location indicated below the STORE label press the Select 
button.  The memory location will auto increment to the next available memory location. 
 
Relative Measurements 
To make a relative power measurement you must first save the reference power level. To store a reference level, 
attach reference cord/s and energize the light source. Enter the Menu mode, scroll to Ref icon and press the 
Select button.  The reference is now stored in nonvolatile memory and displayed at the bottom right of the display.  
The units of the display will now change to dB. Subsequent readings will now be displayed in terms of dB relative 
to the stored reference value. A reference memory location is available for each selected wavelength.  A 
reference reading is required to change to dB measurement from dBm measurements. 
 
Remove the connector from the power meter port and place the fiber under test inline between the reference cord 
and the power meter port.  The reading displayed will be the loss of the fiber under test relative to the reference.   
Ensure the unit is not in Menu mode and press the Select button to store the measurement. 
 
Stored power measurements may be recalled by moving the Scroll Wheel and the File Selector Screen will be 
displayed. If no buttons are press for 5 seconds after entering the File Selector mode, the unit will revert to the 
test mode.   The Scan button may also be pressed to re-enter test mode. 

 
11.2  Autotest Mode 

To use the Auto Test feature, connect the fiber to be tested to a compatible test set. The unit being used as the 
source should be set to Autotest.  If Two Quad OTDRs are being used, only the wavelengths to be tested should 
be selected as sources by entering the Wavelength/Lambda selection menu. Only the wavelengths that are 
energized will be displayed on the power meter end.  Once the source and power meter have cycled through the 
wavelengths to be tested, press the Select button on power meter to store the measurements.  .   
 
Note: A reference measurement is not used in the Auto Test Mode.  The Source is modulated and has power 
level of -3dBm (-6dBm@1625).  This method of measurement does not take into account the launch condition, 
thus the manual method of testing should be used when highly accurate measurements are required such as 
when testing the loss of an individual connector.  The Auto Test annunciator will be displayed during Auto Test 
loss measurements.  Two or more loss measurements are best viewed in the Zoom mode where all the selected 
wavelengths will be display at one time on the display.   
   

11.3  Light Source Operation 
Energizing Light Source 
The lasers are initially in the off state when the LTS is launched.  Enter the Menu mode and use the Scroll Wheel 
to highlight the Source soft key.  Pressing Select will energize the available wavelengths in sequence. 
 
 
 
 

   
 

 
 
 
 

NOTE:   If used with a compatible test set or a companion FTE Series OTDR, the light source will 
transmit the wavelength information automatically to the receiving unit which then changes 
the power meter wavelength setting to correspond to the wavelength of the light source.   
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11.3  Light Source Operation (continued) 
 
Modulating Light Source 
Change the modulation of the light source by entering Menu mode and scrolling to highlight the Modulation soft 
key.  Pressing the select button will toggle through available modulation rates of CW, 270Hz, 1000Hz, and 
2000Hz.   The rate will be displayed directly under the Modulation soft key. When measuring average power of 
the lasers the output will drop by exactly 3.01 dB as the source is off precisely half of the time. The modulation 
function is useful for fiber identification and for general purpose optical component testing. The unit that receives 
one of the modulated frequencies will flash the appropriate frequency annunciator.  
 

 
 
 

 
11.4  File Selector Operation 

File Selector Screen 
Enter the File Selector Screen with the scroll wheel.  In the File Selector screen the soft keys will be inactive and 
grayed out.  The Store location in the bottom left of the screen will be changed to MEM location and there will be 
three loss values on the display.  The middle one is the measurement stored in the indicated memory location 
with the wavelength of the reading to the right. Pressing the A/B button will cycle through the readings stored in 
that location if more than one wavelength was stored.    The grayed out readings above and below the main 
reading, are the measurements of the previous and next memory locations.  If there is not activity in 5 seconds, 
the screen will revert back to the Test Mode. The Scan button will also return the unit to the test mode.   
 
 
 
 
 
Quick File Locator 
To quickly move through the loss storage locations, enter the Menu mode, scroll to the TRC (disc) icon and press 
Select.  The Memory location at the bottom of the display will be highlighted.  Press the Select button to focus the 
highlighted area on just the 1000’s position.  Use the Scroll Wheel to make changes.  Press the Select button 
again to move the focus to the 100’s position and repeat this procedure until the desired storage location is found.  
Scrolling when all the digits are highlighted will move thought the positions one at a time as normal. Press the 
Menu button again to exit the Quick File Locator. 
 

11.5  File Transfer  
To transfer files from the Loss Test Set to the computer, start the certification software.  Connect the OTDR to the 
computer with the supplied USB cable,  on the software tools tab, select Download LTS Files, enter a file name 
and press Save.  The Software will prompt the user to start the Loss Test Set memory download.  To start the 
memory download, enter Menu mode on the OTDR, highlight the File Download Icon and press Select.   The 
download progress will be indicated by the UPLOAD counter in the bottom left corner of the display. 
 
 
 

11.6  Graph Mode  
To view measurements in the Graph Mode, press the Menu button, scroll to the Light Source soft key and use 
the Select button to cycle to the desired wavelength for the test.  If a source other than one compatible for auto-
wavelength recognition with the OTDR is being used, ensure proper the power meter wavelength is selected.  
Once the source is energized and the power meter is taking a measurement, enter the Menu mode, scroll to the 
Eye Icon (view), press Select and the Scan button to start the graph.  Press the Scan button again to stop the 
graph.  The elapsed time of the scan is noted at the beginning middle and end of the graph with the absolute 
value at each of those points displayed. The graph may also be viewed on the certification software.  Please refer 
to the software for information on how to display the graph view on the computer.  To exit the Graph Mode, 
press the select button again with the Eye Icon (view) highlighted. 
 

 
 

NOTE:  Pressing the Select button will overwrite the displayed test with what is in the temporary  
memory. 

NOTE:     (The 3.01dB drop is also true of the laser output when in the Auto Test mode however the 
unit receiving this signal automatically compensates for the loss in average power and this 
is transparent to the user.)

Note:  If there is a communication error occurs, ensure you turn off and restart the OTDR.  
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12.0 Video Scope / Visible Fault  Locator  
 
12.1 Video Scope Operation  
 

The FTE-7500A OTDR can accommodate the PRECISION RATE OPTICS Video Probe.  Located on the bottom 
panel is a an 8pin DIN connector labeled “Vid Probe” The OTDR can view a connector end face, center the image 
and zoom from 200X to 400X.  This feature is accessed from the Home screen.  From startup, scroll to highlight 
the Scope icon and press select.  If the instrument is in another application, press the Menu button, scroll to the 
Exit icon and press Select to return to the Home screen.  Insert the probe and turn on the probe light by moving 
the switch on the probe to the right.  The LED will illuminate indicating the probe light is on.  Insert a connector to 
the probe or insert the probe into a fiber adapters and focus. Use the thumb wheel to focus the image. To zoom to 
400X, press  the Zoom button.  Pressing the Zoom button again will revert back to 200x. 

 
12.2 Video Scope Display 
 

                      

                    
  
 
   
 
 
    
       
 
                            
      

                        
    
 
 
             
               
      
 
 
 
 
 
 
 
 
 
 
12.3 Adjusting Video Scope Image  
 

The Scroll Wheel has two functions in the scope application.  If the Adjust Contrast soft key is shown, the scroll 
wheel will change the contrast of the image.  With Adjust Position soft key is shown, the image may be centered 
by use of the scroll wheel when in the 400X zoom setting.  For positioning, use the scroll wheel as a left-right-up-
down feature by pressing those areas of the wheel.   
 
To change between Adjust Contrast and Adjust Position, press the Menu button and highlight the soft key.  Press 
Select to toggle between the features.  Press Menu to exit the menu mode to use the features. 

 
 
 

Help Icon 
 

Soft Keys 
 

Exit Soft Key 

Note:  Only the Soft Keys 
and the Help Icon are 

accessible on the Video 
Probe display 

Approximately 
400X

Approximately 
200X 
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12.4 Save and Recall Video Image 
 
 Store Video Scope Image to Memory 
 

The Video image may be stored as a Bitmap by pressing the Menu button, scrolling to the Save soft key at the top 
of the display and pressing the Select button.  This will attempt to save the image to the location displayed next to 
the Save soft key.  If that location is occupied by a stored image, a dialog will appear with the choice to overwrite 
that location, save to the next available location or cancel the process.  Scroll to the desired action and press the 
Select button.  

  

 Recalling Stored Video Scope Image  
 To view a stored image, scroll to the Load soft key and press select to view the image at the indicated location.  
 Subsequent presses of the Select button will increment through the occupied storage locations.   
 

   
 
12.5 Copy/Delete Video Scope Image  
 

To copy or delete images, Press the Menu button and scroll to the Copy soft key.  Pressing select on the soft key 
will display a dialog that offers the option of coping all of the images to the PC via the USB/PC port or to a flash 
drive.  The dialog will also offer the option to delete all the stored  video files or cancel the process.  Scroll to the 
desired action and press the Select button.  

        
 

 
 
 
12.6   Visible Fault Locator  
 

.  
 
 
 

 Visible Fault Locator Description 
 The Visible Fault Locator (VFL) is a stabilized fiber optic laser source that emits visible (red) light at 650nm. 
 Its intended function is to allow an operator to identify fibers or find the exact location of a break, micro bend, or 
 other discontinuity in a fiber optic cable. As the radiation is visible, light emanating from a break or micro bend 
 enables the user to locate the exact position of a fault even at very short distances that would not be detectable 
 by other means. It is also useful for identifying a particular fiber in a cable by exciting the fiber to be located with 
 visible radiation.   
 

Visible Fault Locator Operation  
This feature is accessed from the Home screen.  From startup, scroll to highlight the VFL icon and press select to 
cycle through VFL through CW (constant wave) mode or MOD (modulated) mode and Off. If the instrument is in 
OTDR or LTS mode, press the Menu button, scroll to the Exit icon and press Select to return to the Home screen. 
When in the Video Probe mode scroll to the Exit soft key and press Select to return to the home screen.    

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note:  Do Not Remove USB Flash Drive While Accessing. 

Note:   When in the OTDR application and the VFL is required, the active trace will not be lost by   
exiting to the home menu. 

WARNING: Never clean or look directly into the fiber optic connector or the end of fiber attached to the 
OTDR or VFL unit while they are energized, to do so will expose the user to laser radiation 
and could result in personal injury or instrument damage. 



 FTE7500A Manual Rev B 
 2/2012 

- 33 -

13.0 Maintenance 
 
13.1 Battery Replacement 
 

Battery replacement is not recommended however if you must replace the batteries follow these procedures.  
Carefully remove unit from protective boot and remove the two screws from top plate and bottom plate that retain 
the back cover. Carefully remove back cover and remove the two screws that hold the battery covers in place.  
Replace only with 8 AA NiMH 2000mAh batteries.  If you install NiMH batteries that are dead or less than 1 volt 
each, charge these batteries for one (1) hour before using the OTDR. For maintenance, batteries require a 
monthly periodic recharge. 
 
 
 
 
 
 
 
 
 
 

 
 
13.2 Clock Battery 
  

In order to ensure proper Time and Date stamps on test data, it is necessary to energize OTDR for a minimum of 
5 minutes per month.  If this is not accomplished, it will be necessary to reset the time and date  information in 
the Tools Menu. 

 
 
13.3 Laser Out Port 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In order to maintain a low loss fiber connection, care should be taken to adequately clean the ferrule of any 
connector to be inserted in the Laser Out Port. In the event that the port needs to be cleaned, first step is to be 
certain the instrument is off.  We suggest the use of 99% isopropyl alcohol or other industry specific fiber optic 
cleaning products and foam swabs designed for cleaning connectors accepting 2.5mm ferrules. 
 

 
 
 
 
 
 

Note:  For maintenance, batteries require a monthly periodic recharge. 

WARNING:  Do not under any circumstance view or inspect the laser output fibers, connectors, or the 
fiber under test through collimating or focusing optics. A video inspection microscope should 
be used to examine all fiber ends. Contact your PRECISION RATE OPTICS sales 
representative for video microscope information. 

WARNING:     Before connecting to a patch cord or fiber under test, be certain the fiber has no active 
optical sources or instruments connected to the other end. Skin or eye damage could result 
from other high power sources e.g. EDFAs, or instrument damage could occur voiding the 
warranty. 

WARNING: Never clean or look directly into the fiber optic connector or the end of fiber attached to the 
OTDR or VFL unit while they are energized, to do so will expose the user to laser radiation 
and could result in personal injury or instrument damage. 

WARNING:  To Prevent Fire or Shock Hazard: Do not install other battery types; Do not use the 
battery charger without the batteries installed; Do not expose the battery charger to rain or excessive 
moisture; Do not use the battery charger when there are signs of damage to the enclosure or cord; 
Ensure that you are using the correct charger for the local line voltage; Do not use any other battery 
charger than the one provided with this instrument.  Any other condition will void the warranty.   
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13.4 Recalibration and Verification 
 

Periodic verification of the PRECISION RATE OPTICS OTDR is recommended to ensure that your instrument 
remains within specification. Although not imperative, we recommend a recalibration and verification once a year 
to make certain the instrument is functioning properly and performing to its rated specifications. Consult the 
factory for service. 

 
13.5 OTDR Adapter Replacement 
 
 The OTDR is supplied with three easily interchangeable adapters per port, ST/SC/FC. To change an 
 adapter, remove the two screws that hold the adapter in place, pull the adapter straight up from ferrule.  It is 
 suggested that you clean the exposed ferrule with appropriate cleanser and lint free wipe anytime you replace 
 the ferrule.   
 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE:     When replacing the adapter with one that does not have a chained protective cap, use the 
     small screw in place of the larger screw that retains the end of the chain to the adapter 
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14.0 Application Information 
 

 The Terahertz  Technologies Inc.  OTDR is designed to be used as an installation, troubleshooting, and 
maintenance tool. This is a full featured Optical Time Domain Reflectometer.  Our OTDR measures distance and 
loss of fiber links up to 240Km by launching an optical pulse down one end of the fiber and analyzing the returned 
energy in time (or distance) from reflections. The FTE-7500A OTDR uses an advanced high speed embedded 
controller and display processor with proprietary technology to analyze, store and average the fiber trace data in 
the quickest time. This high speed processing engine allows the user to make distance and loss measurements 
immediately after energizing the instrument. With its advanced Event Table, Splice Loss Mode, and dB/Km Mode, 
it also can assist the user in interpreting major events such as bad splices, connections or broken ends. Minor 
perturbations along otherwise normal fiber links can also be detected using a simple moving cursor approach in 
Splice Loss Mode. Complex return signals with many major or minor events can be analyzed by the Precision 
Rate Optics OTDR then stored away for archiving and later retrieval. 
 

As with any OTDR, to assist in obtaining reliable, consistent measurements, the user must be aware of the Index 
of Refraction of their fiber or cable.  The fiber Index of Refraction (IOR) is an important parameter that must be 
entered by the user to maximize the distance measurement accuracy. The IOR is proportional to the speed of 
light in glass compared to the speed in a vacuum and can be calculated by the equation IOR = C (the speed of 
light in a vacuum) / V (the speed of light in fiber). The IOR number can be obtained by the fiber or cable 
manufacturer or can be calculated with a known length of cable. IOR numbers generally fall around 1.468 SM, 
1.486 MM.  These are the default values in the OTDR, but can be adjusted from 1.0 to 2.0. 
 
To calibrate the IOR for your particular fiber, take a known distance of fiber or cable (best if around 1 kilometer), 
and measure the distance with the OTDR set for 2m pulse width, changing the IOR until the measured distances 
closely match. An error of .001 of the IOR entry (1.468 vs. 1.469) equates to an error of approximately 0.7 meters 
per kilometer of distance measured. 
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15.0  Specifications  
 
 

Advanced OTDR Specifications 
Wavelength 850, 1300, 1310, 1490, 1550, 1625nm ±20nm 
Dynamic Range 27/26dB MM, 36/34dB SM, 36/34/34dB TRI
Pulse Width 5 - 20,000 ns 
Units of Measurement km, kf, mi
Event Dead zone 1m 
Attenuation Dead Zone 5m 
Resolution    .125 - 32m
Distance Range 1-64km MM , 1-240km SM 
Typical Real-time Refresh Rate Up to 2 Hz
Group Index of Refraction (GIR) 1.000 - 2.000 
Linearity ± .05 dB/dB 
Memory Capacity ~500 Traces 
Memory Type Internal and Flash Drive 
Connector Styles FC, ST, SC Interchangeable 

Visible Light Source  
Emitter Type Laser
Wavelength 650nm ±5nm 
Laser Safety Class Class IIFDA21 CFR1040.10 &1040.11 IEC 825-1: 1993 
Connector Type 2.5mm Universal 
Output Power <1mW Max. 

Power Meter 
Power Meter Detector Type InGaAs
Calibrated Wavelength 850, 1300, 1310, 1490, 1550, 1625 
Units of Measure dBm, dB 
Resolution 0.01 dB 
Power Measurement Range +5 dBm to -77 dBm   (CATV +25 dBm to -57 dBm) 
Power Measurement Uncertainty ± 0.18 dB under reference conditions, ±0.25 dB from 0 to -65 dBm,         

± 0.35 dB from 0 to +5 dBm and from -65 to -77 dBm  
Autotest Measurement Rate Four seconds per wavelength 
Autotest Range   0 to -36 dB 
Storage Locations 10,000 
Connector Interchangeable ST/SC/FC 

Light Source
Wavelengths  850, 1300, 1310,1550, 1625 ±20nm 
Output Power (CW) 0 dBm  (-3dBm@1625nm) 
Laser Safety Classification Class I safety per FDA/CDRH and IEC-825-1 regulations 
Modulation Modes CW, 270 Hz, 1000 Hz, 2000 Hz 

General Specifications 
Battery Charger Universal
Battery 8hr 
Dimensions (without rubber boot ) 7.75” L x 4.5” W x 2.25” H  

(197mm L x 114mm W x 57mm H) 
Weight 2 lbs 
Communications ports USB PC and USB Flash Drive Ports 
Storage Temperature -20 to 60 C 
Operating Temperature Range -10 to 50 C
Accessories Provided Universal Battery Charger w/US, UK, Continental Europe, and 

Australian Plugs, Interchangeable FC/ST and SC Adapters, 
Windows/Telcordia SR4731 Software, Rubber Boot

 
             Specifications are subject to change without notice 
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16.0 Warranty / Repair / Trouble Shooting 
 
16.1 Warranty Information 
 This product, including all mechanical, electrical, and optical parts and assemblies are unconditionally warranted 
 to be free of defects in workmanship and material for a period of  one (1) year from the date of delivery. 
        
 This warranty does not apply to expendable parts such as batteries, nor to any instrument or component which 
 has been subjected to misuse, alteration, or fiber connector damage. It is the customer’s responsibility to 
 understand all the instructions and specifications prior to  operating this instrument. This warranty does not extend 
 to any loss or damage consequent to the failure of the warranted product. 
 
16.2 Repair 

If repair is required, call Terahertz Technologies Inc. @ 315-736-3642 for return instructions and a RMA number. 
 

16.3    Trouble Shooting     
  

Symptom Possible Cause Solution 

LCD dark Power not on 
 
Batteries require recharging 
 
Batteries are missing, in backwards or 
need replacement 

Press ON/OFF key 
 
Recharge batteries 
 
Check polarity, replace batteries, 
or contact factory for servicing 

LCD white   Power cycled too quickly Turn off wait 5 seconds – turn on 

Instrument locked 
Up 

Unexpected Operational Mode Turn off (hold ON/OFF button in for 1 
second) wait 5 seconds – then 
depress On/Off again button to turn 
the unit on. 

Initial  Backscatter    
low 

Defective cord or dirty connector 
 
Fiber Output port requires cleaning 
 
Angle polish mated with UPC polish 

Replace or clean cord 
 
Clean and inspect port 
 
Examine connector ends 

Extra or “ghost” 
reflections  on 
backscatter     

Fiber too long for short pulse 
 
Fiber over 16Km/53Kft 
 
Fiber over 64Km/200Kft 

Switch to 10m pulse if >4Km 
 
Switch to 100m pulse if >16Km 
 
Switch to 1km Mode if >64Km 

USB hookup to PC 
not functioning 
properly 

USB baud rate not set properly  or too 
quick for computer 
 
 
PC drivers not set properly 

Set port baud rate properly or 
decrease Baud rate in instrument and 
certification software 
 
Uninstall & reinstall certification 
software and drivers 

USB Flash Driver 
not  functioning 
properly 

USB flash drive full 
 
USB flash driver cycled too quickly 

Clean or use a new flash drive 
 
Turn power off wait 5 seconds turn 
back on. 
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17.0    Version Control 
 
 Through a program of continuous improvement the upgrade of the features and performance of this instrument 
are an ongoing process.  The version is displayed on Home Screen in the lower right hand corner of the display.   The 
version changes and approximate release dates are as follows. 
 
 
  
 V2.2a – 1/2012 -  Updated cursor and display measurements. Requires version 1.0 software 
 
 V2.2b – 2/2012 -  Included a Home menu screen, increase the trace size and icon sizes.   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


